
POWERLan Install Help Index

Welcome to the POWERLan Installation on-line help system.    For detailed information on any
topic, click the green underlined topic name.    While in the help system, the Search button 
can be used to locate an Install help topic.    

Help Topics
Before You Install POWERLan
Upgrading POWERLan
Installation Steps
Selecting a Machine Type
Selecting an Adapter Type
Special NetWare Instructions

How to Get Help While Installing POWERLan
Press F1 at any time while installing 
POWERLan for help on a particular 
screen display, prompt or error 
message.    

For additional information on using the on-line help system, select the option "How to Use 
Help" within the Help menu.



Before You Install POWERLan

To ensure a seamless POWERLan installation, we recommend that you do the following:

Ensure that your machine meets all POWERLan hardware and software requirements.    
See System Requirements.

Install the physical network (cards and cables) and make sure they are 
operating correctly.    If you are unsure whether they are operating correctly, contact 
Performance Technologys Bulletin Board (1-210-979-2012) to obtain appropriate diagnostic 
utilities.

Read Chapter 3, Network Planning in the POWERLan Administrators 
Reference.    In addition, the POWERLan Concepts, Features and Benefits Guide provides an 
overview of POWERLan administration.

Know the type of network interface card(s) installed in the machines to be 
networked.    The installation program will prompt for the network adapter.

Decide which machines will be servers and which will be workstations.
Decide which machines will be sharing printers with other network users.
Determine the names of all users, and plan which types of applications and 

resources each network user will need to access.
Determine the level of security required for your network.    For more 

information, read the Network Security in Chapter 3 of the POWERLan Administrators 
Reference.



Special NetWare Instructions

The following section provides instructions for installing and configuring NetWare and 
POWERLan to run on a single network workstation.    

System Requirements
In order to run both NetWare and POWERLan on the same network machine, the following 
hardware and software is required:

Network adapter card which supports ODI
NetWare workstation software
Novell's ODI drivers
POWERLan version 3.1
Windows version 3.1 or greater

Note: In order for POWERLan and NetWare to function properly, your version of Windows 
must include certain NetWare support files.    If these files are not installed on your machine, 
the following message will be displayed when running POWERLan for Windows programs:

Cannot Find NWCALLS.DLL

Windows most recent NetWare support files can be obtained from the following sources:

The latest version of the NetWare client software; or
Windows 3.11 upgrade

Lastdrive (CONFIG.SYS)
Depending on the version of NetWare being run at the workstation, you may already have a 
LASTDRIVE= command within CONFIG.SYS to accommodate NetWare drive mappings.    In 
such cases, all drive letters after the LASTDRIVE are reserved for Novell redirections.

It is important to note that POWERLan does not redirect any drive letter after the 
LASTDRIVE setting.    POWERLan can redirect only from drive A to the LASTDRIVE setting.

If your version of NetWare uses a LASTDRIVE setting other than Z, make sure there are a 
sufficient number of drive letters available for use by POWERLan.    For example: if 
LASTDRIVE=M

Drives A through M will be allocated to POWERLan redirections. 
Drives N through Z will be allocated to NetWare redirections.    NetWare will assign 
mapped drives starting at N.

Before You Install or Configure POWERLan
To ensure a successful POWERLan installation and integration with NetWare, it is strongly 
suggested that NetWare and Windows be installed and operational while installing 
POWERLan.

The following steps should be performed before POWERLan is installed or configured:

1. Install NetWare and Windows on your workstation (if not already installed) according to 
the manufacturer's instructions.    



2. Ensure that Novell NetWare is selected as the network operating system under Windows
(use the Change System Settings selection within the Options menu).

3. Test your NetWare and Windows installation by connecting to network drives using the 
Windows File Manager.    Do not proceed to the POWERLan Installation and 
Configuration until this operation is verified.

Once you have verified that NetWare and Windows are fully operational, you may proceed 
with the POWERLan installation.

Note: Make sure that NetWare is running before you start the POWERLan installation.    The 
POWERLan install program detects the presence of NetWare and asks if you want to 
configure your machine to run both NetWare and POWERLan.    The install program will then 
attempt to configure your machine for dual network use.

If your machine requires manual configuration for dual NetWare / POWERLan use, refer to 
the section Running POWERLan and NetWare within the POWERLan Setup program's on-
line help.



System Requirements
POWERLan for Windows machines must meet the following requirements:

MS-DOS must be installed on each machine (versions 3.30 through 6.0 are currently 
supported).    For non-dedicated servers, ensure the DOS program SHARE.EXE is in the 
DOS directory (and is included in the PATH= statement).

Windows version 3.1
Network interface card.    A detailed list of supported network interface cards is

included in the software package and is also available from your dealer or Performance 
Technology sales department.    

Note:    If you do not use a card supported by POWERLan, successful 
installation or operation of your network cannot be guaranteed.



Novell NetWare is your current network.    Do you wish to add
POWERLan as a second network?

The install program has detected NetWare as the network operating system.    Select one of 
the following options:

Add POWERLan:    Configures Windows, your ODI driver and NET.CFG for dual network 
operation (NetWare and POWERLan).

Replace NetWare:    Removes NetWare from Windows as the network 
operating system.    The machine will be configured to run under POWERLan alone.

Cancel:    Exits the install program.



Do you want to upgrade?

The install program allows you to perform either a complete or an "upgrade" installation, 
depending on whether or not POWERLan is already installed on this machine.

Select Yes to upgrade to the new version of POWERLan.    This option will copy all 
POWERLan program files to your machine.    In addition, certain Windows drivers will be 
installed.    

The upgrade installation does not prompt for machine configuration settings.   
Your existing settings (machine type, logon type, NetBIOS, workstation and server settings) 
will remain intact.

NetWare Note: Upgrade installations do not automatically configure your 
machine for dual POWERLan/NetWare use.    All ODI configurations must be performed 
manually after installation.    

Select No to perform a complete installation.    The install program will copy all
POWERLan program files and prompt for machine configuration parameters.

NetWare Note: When running a complete installation, POWERLan will 
attempt to automatically configure your ODI network driver and NET.CFG file for dual 
POWERLan/NetWare use.



Upgrade POWERLan files in

Enter the directory in which your current POWERLan files are installed.    The default value is 
c:\PL.

This entry must reflect your current POWERLan directory.



Installation Steps

To Install POWERLan:
1. Install POWERLan under Windows by inserting the POWERLan Install disk in drive A (or 

B) and entering the following at the DOS prompt:
WIN A:INSTALL

Install can also be run from within Windows using the Program Manager using the Run 
option within the File menu.
Press F1 for help at any time during your POWERLan installation, or consult the 
POWERLan for Windows User's Guide for additional installation information.

2. If NetWare is running, you will be prompted for the following:
Novell NetWare is your current network.    Do you wish to add POWERLan as a 
second network?
Select one of the following options:

Add POWERLan:    Configures Windows, your ODI driver and NET.CFG for dual 
network operation (NetWare and POWERLan).

Replace NetWare:    Removes NetWare from Windows as the network 
operating system.    The machine will be configured to run under POWERLan alone.

Cancel:    Exits the install program.
3. The prompt Do you want to upgrade? is displayed if you currently have POWERLan 

installed on your machine.
Refer to the section Do you want to upgrade for details on the differences between a 
complete installation and an upgrade installation.

4. Verify the "Install from" and "Install to" fields.    These fields are automatically entered by
the install program.
Install From:    The location (drive and directory) of the POWERLan installation files.    
For example, if installing from a floppy, Install From may display A:\ or B:\.
Install To:    The default POWERLan directory on you machine's hard disk.    If you 
require a different location for the POWERLan program files, enter the drive and 
directory name.    The install program will create the directory if it does not already exist.

5. Select the type of POWERLan machine to install (Workstation, Non-dedicated Server, or 
Dedicated Server).    For more information, see Selecting a Machine Type.

6. Select the network adapter being used in this machine.    For more information, see 
Selecting an Adapter Type.

7. Select the Install button.    All POWERLan program files will be copied to the POWERLan 
directory specified in Install To.    

8. After all POWERLan files are copied, you will be prompted to specify certain 
configuration parameters based on the installation type (Workstation, Non-dedicated 
Server, or Dedicated Server).    
The configuration questions will be asked only if this is a new installation.    If you are 
upgrading, your current configuration settings will be applied. 
Press F1 during any of these configuration prompts for help on a specific install item.



Selecting a Machine Type

During installation, you must select the type of machine that will be running POWERLan.    

A workstation is a computer that can 
access (or USE) disks and printers on 
other network machines.    Workstations 
cannot share their own disks with other 
network users.    They can, however share
a local printer with the network.
A non-dedicated server is a machine on 
the network that can share it's local disks
with other network users and still run 
other applications (such as word 
processing, spreadsheets, etc).
In addition to disk sharing, a non-
dedicated server can also share a local 
printer with the network.
If there are files on your machine that 
you would like to share with other 
network users, select non-dedicated 
server.
A dedicated server is a network machine 
that shares it's own local drives with 
other network users.    
In addition to disk sharing, a dedicated 
server can also share a local printer with 
the network.
A dedicated server cannot run other 
applications (such as word processing or 
spreadsheets).

Selecting an Adapter Type

When installing POWERLan, you must specify the type of network interface card (NIC) in this 
machine.    

Click  to display a list of the adapter card choices, as well as an other and none.

The install program will configure the NetBIOS for this machine based on the adapter card 
chosen.    Your machine will be configured with default NetBIOS settings which have been 
designed to suit the typical POWERLan installation.

Adapter and NetBIOS settings can be reconfigured after installation using the POWERLan 
Setup program.



Do you want a minimal installation?

Before copying files, POWERLan detects whether there is enough disk space on the 
destination media for all files.    If not, a minimal subset that will make the network 
operational is copied.    

Select Yes to continue installation of a workstation, and install only the minimum files 
required.    

A minimal installation requires approximately 368K for Ethernet or 390K for ARCNET.    Only 
six or seven files (depending on the board type selected) are copied:    REDIR.EXE, NET.EXE, 
PLADMIN.EXE, PLR.EXE, NETSHOW.EXE, and the NetBIOS corresponding to the board type.    

Select No to return to the POWERLan Installation dialog box to change the destination field.

Minimal Install Note:
If you are installing to a 360K diskette, the configuration programs will not be included in the
installation.    To make changes to the configuration, you will need access to either the 
Windows Setup program or the DOS PLADMIN program (typically off a redirected network 
drive). 

In addition, if you later want this machine to share a printer, you will have to manually copy 
the PRTUNSPL.EXE file from the release diskette to this diskette.    This file is required for 
sharing printers.



Insert Disk

During the install procedure, you will be asked to insert specifically labeled installation disks.

Please insert the specified POWERLan installation disk.



Are you sure you want to cancel the installation?

Select Yes to cancel the POWERLan installation.    The install program may have already 
started copying the new POWERLan program files to your machine.    These files will be 
located in the "Install To" directory specified at the beginning of the install program (C:\PL).

Select No to continue the POWERLan installation.



Copying Files

POWERLan's program files are now being copied to your machine.    If required, you will 
prompted to insert an additional installation diskette.



Installation Error Messages

The following errors may occur during installation:

Destination directory cannot be the same as the source 
You must specify a destination directory in the To: field that is different than the 
source (the From field).

Error creating destination directory
The destination directory you specified could not be created.    The destination may 
have read-only access or be write-protected.

Error creating temporary file in destination directory 
A temporary file could not be created in the destination directory you specified.    The 
destination may have read only access or be write protected.

Error obtaining drive information
Hardware problem with drive.

Error reading installation file
The installation diskette may be faulty.    Contact Performance Technology or your 
dealer for a replacement.

No files need to be installed or updated 
The files have already been installed or updated.

Not enough disk space: <n> bytes needed, only <n> free
Take whatever action necessary to free more disk space and try the installation again.

Not enough memory to allocate copy buffer
Take whatever action necessary to free more memory and try the installation again.

You must specify a drive and directory for the destination 
Check your entry and make sure that you have specified both a drive and a directory,
and that the syntax is correct.

You must specify a drive and directory for the source 
Check your entry and make sure that you have specified both a drive and a directory,
and that the syntax is correct.



DOS Error Messages

Any of the following MS-DOS error messages can occur during installation.    For more 
detailed information on resolving MS-DOS-related network problems, consult the DOS 
reference materials provided by your vendor.    

Remember that POWERLan displays it's errors in DECIMAL.

DOS Error Codes
HEX Decim

al
MEANING

01 01 Invalid function number
02 02 File not found
03 03 Path not found
04 04 Too many open files (no handles left)
05 05 Access denied
06 06 Invalid handle
07 07 Memory control blocks destroyed
08 08 Insufficient memory
09 09 Invalid memory block address exceeded
0A 10 Invalid environment
0B 11 Invalid format
0C 12 Invalid access code
0D 13 Invalid data
OE 14 Reserved
0F 15 Invalid drive was specified
10 16 Attempt to remove current directory
11 17 Not same device
12 18 Attempt to write on write-protected disk
14 20 Unknown unit
15 21 Drive not ready
16 22 Invalid disk command
17 23 Data error (CRC)
18 24 Bad request structure length (Disk error)
19 25 Seek error
1A 26 Unknown media type (Not MS-DOS disk)
1B 27 Sector not found
1C 28 Printer out of paper
1D 29 Write fault
1E 30 Read fault
1F 31 General failure
20 32 Sharing violation
21 33 Lock violation
22 34 Wrong disk
23 35 FCB Unavailable
24 36 Sharing buffer overflow

25-31 37-49 Reserved
32 50 Network request not supported
33 51 Remote computer not listening
34 52 Duplicate name on network
35 53 Network name/path not found
36 54 Network busy
37 55 Network device no longer exists



38 56 NetBIOS command limit exceeded
39 57 Network adapter hardware error
3A 58 Incorrect response from network
3B 59 Unexpected network error
3C 60 Incompatible remote adapter
3D 61 Print queue full
3E 62 Print queue not full
3F 63 Print file was canceled (not enough 

space)
40 64 Network name was deleted
41 65 Access denied
42 66 Network device type incorrect
43 67 Network name not found
44 68 Network name limit exceeded
45 69 NetBIOS session limit exceeded
46 70 File exists
51 81 Reserved
52 82 Cannot make directory entry
53 83 Fail on INT 24
54 84 Too many redirections (Out of network 

resources)
55 85 Duplicate redirection (Device already 

assigned)
56 86 Invalid password
57 87 Invalid parameter
58 88 Network data fault



No Help is Available

No help is available for this topic.




